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http://culturedays.ca/

What is
Culture Days?

Culture Days is Canada’s
annual celebration of arts,
culture and heritage.

Collingwood Art Crawl. Collingwood, ON
Photo courtesy @experience.collingwood

Every year, thousands of free
and PWYM arts and cultural
events take place across the
country. Welcoming millions to
create, share, and celebrate a
life enriched by arts and culture.

CULTURE DAYS 2025:
SEPTEMBER 19 — OCTOBER 12

Marion Webber Open Studio: Celebrating 30 Years of Art! Richmond, BC
Photo courtesy Marion Webber


https://www.instagram.com/experience.collingwood/
https://www.instagram.com/experience.collingwood/

Who can participate?

Anyone! From grassroots volunteers, libraries, and
Independent artists to major institutions, festivals,
and municipalities — everyone is invited to join the
celebrations.

How to participate?

You participate in Culture Days by organizing a free or
PWYM, arts, culture or heritage-focused event during
the Culture Days dates and registering it on the Culture
Days event registration system.

REGISTERING YOUR EVENTS

registration culturedays.ca/dashboard ATy
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Nature’s Threads. Ebru Winegard. City of Barrie, ON.
Photo by Fernanda Sierra Suarez



Dashboard Registration Tools

Enable RSVPs

If you would like to collect sign-ups or registrants for
your events, activate our system’s RSVPs during event
registration and allow attendees to sign-up/reserve a
spot to your event through your Culture Days event

page.

« YOou can set a limit for registrants, and view or
manage registrations.

« In the Events tab in your Dashboard, you can set up
RSVPs when you create the event In the Events tab,
choose the event, and click on Edit., as well as a
registration deadline.

« Once you Save and Publish the event, you will
receive email notifications whenever someone
registers using the RSVP tool.

Play With Your Food! Printmaking Workshop with Marlene Yuen. Richmond, BC
Photo courtesy the Richmond Art Gallery



Dashboard Registration Tools

Eventbrite Import

o Alternatively, if you are already
using the platform Eventbrite to
collect registrations, you can
connect it to your Culture Days
event listing and import details from
Eventbrite to auto-populate your
Culture Days event form.

« YOu also have the option to embed - - &
checkout so visitors can register or e
reserve tickets without leaving the a8
Culture Days website. . R '||'“’E#“-.‘iii}l';“ﬁijﬁ?iiﬁi¥fif
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Caledon Creative Arts Festival. Caledon, ON. Caledon's Culture Days 2024
Photo courtesy the Town of Caledon

Dashboard Registration Tools

Support your event promotion and management
directly from your Culture Days dashboard.

Embed Widgets

« To add a widget to your website, first go to
the ‘Embed Widgets’ tab on the left-side
menu of your Dashboard. At the top of the
page, you will find detailed instructions on

how to copy and add the code of each
published event or Hubs.

« You do this by copying the embed code and
clicking the "Copy snippet" button, then

pasting it into your webpage where you want
the widget to appear.



' A collective campaign

Experienced Locally,Celebrated Nationally

15 YEARS
55,000« EVENTS

25M+ ATTENDEES
17,000+ ORGANIZERS
5,000+ COMMUNITIES

Toronto Symphony Orchestra Open House, ON
Photo by Allan Cabral



Public engagement campaign

Culture Days is an opportunity to collectively
showcase the arts, culture, and creativity in
communities across Canada, and to amplify
their impact and value.

Leverage the Culture Days campaign

Align Your Messaging. Link your event’s messaging
and promotions with the Culture Days’ campaign to
highlight arts and culture’s value.

Culture Days Marketing Drive:

® Culture Days Key Messages 2025 (DOC & PDF)

® Outreach One-Pager (PDF)

® MP Outreach Letter Template (DOC)

@ Culture Days 101 Info Deck (PDF)

@ Press Release + Media Advisory Templates (PDF & DOC)

Richmond Cultural Centre & Public Library.
Richmond, BC. 2023. Photo @richmondhillpl


https://www.instagram.com/richmondhillpl/

Amplify your reach with

Culture Days tools

Target Your Reach. Use event tags (art form,
language, theme, accessibility) to connect with
your desired audiences.

Be Found on the Map. Take advantage of the
geo-location map at culturedays.ca/events so
nearby audiences can easily find your events.

Create Event Hubs. Group events by theme,
location, or shared community to increase
visibility and encourage attendance.

® Find a step-by-step guide at
culturedays.ca/dashboard/hubs

Nuit Blanche Winnipeg, MB
Photo by Red Photo Co, Exchange District BlIZ
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2023 Ambassador in Kelowna, BC
Cameron Gelderman. Photo by Mallory Gemmel

Join the campaign

Once your event is registered and published, you’ll
get access to a variety of marketing assets in your
Dashboard at culturedays.ca/dashboard.

Using these materials connects your event to both
the Culture Days national and regional campaigns.

Whether you use ready-made assets or customize
templates, you can tailor promotions to fit your
unique events and community!




Making the Campaign Your Own
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Brantford Culture Days on the Trails, ON Glass Mosaics at Art. Now/Craft Is...Saskatoon, SK
Photo courtesy the City of Brantford Photo courtesy of Saskatchewan Craft Council



Making the Campaign Your Own
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Slavik - Slovak Folkore Society Dance Workshop in Vancouver, BC Passport Printmaking with Jacquie Sullivan. Scugog
Photo courtesy of Slovak School in Vancouver Arts, Port Perry, ON. Photo by @jacquieprints



culturedays.ca/dashboard >

Tools > Marketing Materials >

Culture Days Marketing Drive

« Ready-to-post
promotional assets

« Customizable Digital and
Social Media Graphics

« Canva Templates

ARTS.
CULTURE.
COMMUNITY.

« Animated Frames

« Multilingual Assets
« Campaign Print Posters P CULTURE
« DIY Swag

« Outreach Templates

T
DAYS E culturedays,ca


https://culturedays.ca/dashboard

culturedays.ca/dashboard >

Tools > Manage & Promote >

Social Graphics

Create ready-made promotional
graphics for your event directly
from your dashboard.

1.Choose layout

2.Select size - 3x4 or 9x16
3.Select Timeslot

4.Add an image from your

published event
5.Pick your panel colour
6.Select language (EN or FR)
7.Download and share online

Sep 20, 11:00 am. - 3:00 p.m.

CARVING AND PRINTING BIRD

Organized by The Sierra collective

Allan Gardens Conservatory
Toronto, ON

Organized
¥ The Sier,
Collective !

Allan Gardens Co.

nserva
Toronto, on tory

CULTUY
DAYS =



https://culturedays.ca/dashboard

Culture Days Marketing Drive >
Digital & Social > Social Media Template Links >

Canva Templates

You can add your own photos and event information to
any of these Culture Days templates in Canva!

1.Click on a link in the “1. Social Media
Template Links (Canva)” document to
open template of your choice

2.Click File > Make a Copy

3.Edit the design and make it your own!

Note: You will NOT need to request edit
access in Canva. You will be able to edit
this template by clicking “File” at the

top left, then “Make a copy.”


https://culturedays.ca/dashboard

Online Accessibility

Accessible content helps your message reach

more people and your online promotions are
inclusive and accessible.

« Check contrast & colour — use WebAIM’s
Contrast Checker to ensure text is readable.

« Choose accessible fonts — sans serif fonts are
preferred for graphics.

- Add alternative text (alt text) to describe
Images for screen readers.

» Include image descriptions in captions to
make visual content accessible to all
audiences.

“Who Can Experience My Post? An Accessibility

Guide to Everyday Social Media

Developed in collaboration with Yasmeen Nematt Alla

New Works: Pop Up. Dances Festival 2024
Granville Island, BC. Photo by Marco Esccer



Social Media Engagement

« Monitor your own feed, what are your followers
sharing, talking and posting about?

o If possible, use a social calendar tool to plan
content and schedule it in advance

. Reply to comments and private messages to
increase engagement

Content ideas

« Diversifying the format (reel, video, photos) of your
messages allows you to reach more audiences

« Explore interactive content such as post polls and
guestions

Zine Workshop. Prince Albert, SK. Photo by: All My
Relations Photography




We encourage you to connect with
us, and our regional partners via
social media - before, during, and
after Culture Days to help

showcase your events!

Connecting via @culturedays

« Share your best photos & videos from your
events

« Use the key visual guide and hashtags to
connect with the national campaign

« Consider collaborative posts with your
event partners to amplify your posts

« Tag Culture Days regions to extend your
reach even further

 Repost relevant Culture Days content

Parol (Filipino Star Christmas Lantern) Making with the Parkland
Filipino-Canadian Association in Yorkton, SK.



How to tap into local media and community networks

Carrot (the offer) :

What's special, unique, rare, novel or
transformative about your event,
class, workshop, experience, etc?

Relate it (tie it together)

Using your carrot and what you know
about your audience, what's the best
way to describe and talk about your
event so they'll be interested? How
can you remove barriers to "no"?

2
Audience (your fans)

Who does your offer appeal to?
Who/what kind of person would be
Interested? There are those fans who
exist already and those who could be, if
only they knew about you.

4
Expand and collaborate

What like-minded organizations and
Individuals could you work with to
spread the word and promote
participation?



Diljit Dosanjh Will Make History as the First Artist on
the Cover of Billboard Magazine in Canada

Arts coverage overview

Artists completely transform Toronto home set
The first print edition of Billboard Canada will feature exclusive photos of the Punjabi superstar, plus behind- s
s image king Dil-Luminati tour. The ition will be available fD I dem (0] | ition

covers, including one s SE ion as part of a global
It'll be a tear-down, but not before it's a canvas for a team of artists
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Diljit Dilj

How to build an eclectic collection
Introduction to Encaustic of works by emerging artists Consuming arts and culture is good for people’s health, new research finds

Demo - Culture Days
Event




Key Dates and Reminders

o Culture Days - Public Engagement Campaign
August - October 2025

o Culture Days Event Period:
Friday,_ September 19 to Sunday, October 12, 2025

« National Day for Truth and Reconciliation:
Tuesday, September 30, 2025

« Event registration is open until a day before
Culture Days begins
Thursday, September 18, 2025

ARTS.
CULTURE.
COMMUNITY.

CULTURE
DAYS

SEPT 19 - OCT 12



REGIONAL NETWORKS

YUKON

CULTUREDAYS.CA/YT
@TRAVELYUKON

BRITISH COLUMBIA

CULTUREDAYS.CA/BC
@BCCULTUREDAYS

SASKATCHEWAN

CULTUREDAYS.CA/SK
SASKCULTURE.CA
@CULTUREDAYSSK

MANITOBA

CULTUREDAYS.CA/MB
@MBCULTUREDAYS

ONTARIO

ONCULTUREDAYS.CA
@ONCULTUREDAYS



https://culturedays.ca/en/bc
https://www.instagram.com/bcculturedays/
https://culturedays.ca/en/sk
https://www.saskculture.ca/programs/saskculture-programs/culture-days
https://www.instagram.com/culturedayssk/
https://onculturedays.ca/
https://culturedays.ca/en/mb

REGIONAL NETWORKS
ALBERTA

 Provincial Alberta Culture

QUEBEC

 Les Journées de la culture,

Days runs the whole month produced by ‘Culture pour
of September tous’

» Alberta Culture Days Grant . 3-day provincial celebration
Program

« Additional events listing

« Separate events listing

CONTACT: fIONTACT:
albertaculturedays.gov.ab.ca Journeesdelaculture.qc.ca

ALBERTA.CA/ALBERTA-CULTURE-DAYS



https://www.journeesdelaculture.qc.ca/
https://www.alberta.ca/alberta-culture-days

culturedays.ca/newsletter

iInfo@culturedays.ca

@culturedays

@CultureDays

Culture Days | Féte de la culture

Culture Days | Féte de la culture

HYO@0O0

Elisa Rutledge Plain Air Painting Workshop, Pictou County, NS
Photo courtesy Creative Pictou


https://twitter.com/CultureDays
https://www.facebook.com/CultureDays.Fetedelaculture
https://www.linkedin.com/company/culture-days?originalSubdomain=ca
https://culturedays.ca/en/newsletter
https://www.instagram.com/culturedays

